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* 1875: Richard Canton — Primo a registrare ’attivita
elettrica del cervello. Osserva delle fluttuazioni
dell’attivita elettrica correlate all’attivazione delle

funzioni cerebralli.

* 1920: Hans Berger — Prima registrazione del segnale
EEG. Scopre le “onde cerebral1”
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Berger’s EEG recording apparatus Berger’s electrode cap
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GENERAZIONE DEL EEG
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EEG signals are generated by the integration of neural activity at multiple
spatial (A) and temporal (B) scales.

Le Van Quyen, M. (2011). The brainweb of cross-scale interactions. New Ideas Psychol. 29, 57-63.
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ACQUISIZIONE DEL SEGNALE
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Potenziale elettrico relativo alla attivita cerebrale registrato sullo
scalpo in posizioni standard (sistema 10/20)

Ampiezza: 50 - 100 uV Banda: 1 - 50 Hz
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ESEMPI DI INTERFACCIA

« Minimo 19 elettrodi
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SISTEMA DI ACQUISIZIONE

Cute s.gra.ssat'e.l con alcool, per pasta conduttrice applicata elettrodo viene avvitato in
diminuire I'impedenza del sull'elettrodo posizione, sistema 10-20
circuito
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ALTERAZIONI DELLA MORFOLOGIA

Sofferenza cerebrale da scarsa ossigenazione
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ALTERAZIONI DELLA MORFOLOGIA

Coma profondo da prolungato arresto cardiaco
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Addormentamento fisiologico (soggetto adulto normale)
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https:/ /www.youtube.com/watch?v=XMizSSOejg(



%, UNIVERSITA
48 DEGLI STUDI DI TRIESTE

RITMI EEG
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ANALISI QUALITATIVA
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QUANTITATIVE EEG

e Electroencephalogram(EEG)-brain related electrical
potentials recorded from the scalp

* Quantitative EEG(qEEG)-Mathematical processing of
digitally recorded EEG in order to highlight specific
waveform components, transform the EEG into a format or
domain that elucidates relevant information, or associate
numerical results with the EEG data for subsequent review

or comparison
°

Reliability of quantitative EEG features

A
ELSEVIER

Steinn Gudmundsson *°, Thomas Philip Runarsson °, Sven Sigurdsson *,
Gudrun Eiriksdottir €, Kristinn Johnsen ©*




ANALISI DEL SEGNALE

Attivita sincrona di popolazioni
di neuroni - produce
oscillazioni

DOMINIO DELLA DOMINIO DEL
FREQUENZA TEMPO

ANALISI TEMPO-
FREQUENZA

EEG
Segments

________________

J
/.

Valtage (V)

————————————————

#oe, UNTVERSITA
»/ DEGLI STUDI DI TRIESTE

Averaged ERP
Waveform

| PN Ll |
T T T T 1
200 400 600
Time (ms)
-2
10 (o] 10 20 30 50
frequenza

Frequency (Hz)
S 8

—
(=]

Time (min)

0 5 i
-30 -20 -10 0 10 20 30 40

L
o

-

L

& &
(*n"e Bon) Jamod Gon




7. UNIVERSITA
2 DEGLI STUDI DI TRIESTE

BRAIN MAPPING: LE AREE CEREBRALI

Ogni regione cerebrale puo DI UETI2IN ATEaS
essere associata con una
specifica funzione

International 10-20 System of Electrode
Placement

long term memory
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BRAIN MAPPING: IL DOMINIO DEL 8B’ peowsTupi b TiESTE
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Makeig et al, 1999
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BRAIN MAPPING: IL DOMINIO DEL DEGLI STUDI DI TRIESTE
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BRAIN MAPPING: IL DOMINIO DELLE cetiiC IRV
FREQUENZE
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EEG spectral signatures of healthy and psychiatric populations. (Panel A) Mean
(£ SEM) EEG power spectra of healthy control subjects (red) and psychiatric patients
(blue). (Panel B) Mean subgroup spectra for controls (CON) (red, n = 18), schizophrenia
spectrum disorder (SSD) (purple, n = 14), obsessive-compulsive disorder (OCD) (green, n =
10), depression disorder (DD) (light blue, n = 5).

Shulman et al, 2011
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Z-SCORES: DISTINZIONE
NORMALE/PATOLOGICO

HORMAL
RANGE
TO0 wlu Low MoK
t ' e ———
-3 -2 -1 0 1 2 3 3.2 4 0 1 2 3 SR A0 28
Z SCORES = Standard Deviations from the Mean  spNORMAL ELECTRICAL ACTMITY GREEN=NORMAL ELECTRICAL ACTIVITY

RED=EXCESSIVE BLUE=DIMINISHED

*E necessario definire dei range di normalita = derivano dalla
popolazione dei controlli

Z-score: rappresenta la distanza normalizzata (in numero di
deviazioni standard) di un certo valore rispetto alla media ed e definito
nell’intervallo [-3 ; 3]

Le diverse patologie possono essere definite in termini di differenza di
attivita EEG nelle diverse aree cerebrali alle diverse frequenze
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« Potenza Assoluta (absolute power):
quantita di segnale EEG in una certa banda
(integrale della potenza di ciascuna
frequenza in una certa banda)

.
-
Wik
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e
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.

« Potenza Relativa (relative power):
contributo al’EEG di una certa banda
rispetto alla potenza totale (rapporto tra la
potenza assoluta in una banda e la potenza
totale)

« Coerenza (coherence): relazione di fase
(sincronizzazione) tra oscillazioni registrate
in diversi elettrodi (misura della relazione
tra oscillazioni in diverse aree cerebrali)

20 25 30

« Asimmetria (inter-lead asymmetry):
differenza della potenza in banda tra due
sitli, normalmente valutata nei due emisferi
(destra vs sinistra)
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Z-SCORES: ESEMPI

EEG Signatures for ADHD
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gEEG: IL VALORE CLINICO

Article

Clinical EEG and Neuroscience
44(4) 273-285

Clinical Advantages of Quantitative § EEG and Cica Newroscincs

Electroencephalogram (QEEG)-Electrical cxepubcomlipurmaermissions v
. . . . . DOI: 10.1177/1550059412475291

Neuroimaging Application in General ecg sgepubcom

Neurology Practice ®SAGE

J. Lucas Koberda', Andrew Moses"z, Paula Koberda"z, and
Laura Koberda'"?

* 150 qEEGs analizzati per valutare I'utilita clinica (contributo
alla diagnosi o al decision-making/trattamento)

* Definiti 5 gruppi principali - epilessia, cefalea, trauma cranico,
declino cognitivo, attention deficit disorder (ADD)

* I1 gEEG contribuisce clinicamente nel 95% dei casi
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EPILESSIA

Z Scored FFT Summary Information
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Absolute Power
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Figure |. A, Patient with epilepsy had right temporal increase in 0 power; second picture from the upper left shows increase in the right tem-
poral 0 power, yellow color indicates that this area is between | and 2 standard deviations (SDs) from the norm. B, Low-resolution electro-
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Z Scored FFT Absolute Power
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Increased absolute
FRONTAL BETA
power in patient with
chronic headache
(HA); frontal red area
(between 2 and 3
standard deviation
[SD])
in pictures shows 13 to
20 Hz frequency (green
color shows areas
between 0 and 1 SD;
yellow between 1 and 2
SD).
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TRAUMA CRANICO

Z Scored FFT Relative Power
Waming: Absolute power must be consulted 1o nterprat relative power
2H:z Nz

Patient with PCS had
increased bilateral
TEMPORAL (6 Hz)
THETA power (at 6
Hz frequency bilateral
temporal power is in
red indicating it is
within 2
to 3 standard
deviation [SD] from
the norm
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DECLINO COGNITIVO

Z Scored FFT Summary Information

Delta Theta Alpha Beta High Beta
Absolute Power
&

.- S
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Figure 4. A, Patient with progressive cognitive problems had increased frontotemporal ) power (yellow color is between | and 2 standard
deviation [SD] in absolute power and red color between 2 and 3 SD in relative power). B, Low-resolution electromagnetic tomography analysis
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ATTENTION-DEFICIT DISORDERS

Z Scored FFT Summary Information

Delta Theta Alpha Beta High Beta

Absolute Power

Relative Power

32101 23

Figure 5. A, Patient with attention deficit disorder (ADD)/Asperger syndrome (AS) showed increased frontotemporal 6 power (yellow areas
|-2 standard deviation [SD]; red 2-3 SD). B, Patient with diagnosis of ADD/AS showed increased 0/ ratio (yellow areas |-2 SD; red areas 2-3
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NEUROFEEDBACK

“Normalizzazione” dell’attivita oscillatoria tramite
giochi/esercizi/compiti che variano in base all’ampiezza
delle oscillazioni nelle diverse bande

Il soggetto esegue il compito e ha come feedback un
parametro qEEG (tipicamente la potenza assoluta o
relativa della banda che risulta non normale)

Il soggetto impara la strategia mentale per mantenere il
valore della banda nel range di normalita
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STRUMENTAZIONE PER

NEUROFEEDBACK

 Hardware |
— Testina EEG | ¥y
— Elettrodi/cuftfia @
e Software

— Programmi per 1’acquisizione, analisi €
visulizzazione del segnale EEG

— Video games, movie player, ....
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OBIETTIVO

7.0D-W

Post 40 sessions of EEG Biofeedback, Normal
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UNA STORIA...

https:/ /www.youtube.com/watch?v=hNR_DitnSe4

Chris Kaman’s Story
*NBA basketball player for the Clippers
*Diagnosticato di ADHD a 3 anni
*Ha forti problemi di concentrazione
L’analisi EEG mostra in realta un aumentato ritmo
beta
Il neurofeedback gli permette di comprendere come
tenere il ritmo beta sotto controllo e migliorare anche le
performance sportive
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NEUROFEEDBACK IN CLINICA:

PEDIATRIA

Table 1
Evidence for NF for pediatric ADHD, LD, autism, and epilepsy, based on criteria by the USPSTF
level of certainty of research evidence and recommendation grade

Quality of Evidence for Children
or Adolescents/Clinical

Disorder Recommendation Basis of Recommendation
ADHD Fair to good/recommend (with 12 published RCTs (4 are sham-controlled
reservation) with nonsignificant effects that did not

use optimal protocols)

Autism Fair/recommend (with reservation) 4 small RCTs (2 sham-controlled with
significant effects, 1 wait-list control
with several improvements, reportedly
maintained over a period of 6 mo, and
1 compared with a biofeedback
condition and a wait list)

Learning Poor to fair/insufficient evidence to 2 studies using operationalized

disorders make a recommendation definitions and assessments of LD, and
1 small RCT
Epilepsy Poor/insufficient evidence to make a There are no clinical trials specific to
recommendation pediatric epilepsy, although children

and adolescents have been included in
trials of NF for epilepsy; 2 meta-
analyses of NF reported 82% of subjects
experienced >50% seizure reductions®”
& 79% statistically significant reduction
in frequency of seizures®”

Hurt et al, 2014
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NEUROFEEDBACK IN CLINICA:

ADOLESCENTI

Table 2
Evaluation of surface NF in youth: the evidence base
Quality of Strength of
Indications NF Method Research Recommendation Evidence Base
Depression Alpha asymmetry Fair Recommend 1 case study®®
Anxiety Increase alpha/theta Fair Recommend 1 RCT”?
ratio or SMR/theta
ratio
Performance Alpha/theta training Good Recommend 1 RCT and 1 open
anxiety trial®’ 1>
Mental NF based on individual Good Recommend 2 clinical trials
retardation qEEG
TBI Decrease theta/increase Fair Recommend 1 RCT comparing
beta physical therapy
with NF
PTSD Decrease delta/theta Fair Recommend Non-randomized
activity controlled study
Alcohol abuse  Alpha/theta training ND ND ND
Substance abuse Alpha/theta training ND ND ND

Simkin et al, 2014
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qEEG IN PRATICA: L’'INDICE BIS

I1 BIS rappresenta un indice in uso nelle sale operatorie da qualche
anno, e ha dato origine ad una vasta letteratura. Il BIS fornisce in tempo
reale un numero fra o e 100 proporzionale al grado di ipnosi: 100
corrisponde al paziente sveglio, 0 all’assenza di attivita elettrica
cerebrale.

aumento del
livello di risveglio
coscienza

induzione

profonda

60 80
Tempo (minuti)
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IL CALCOLO DEL BIS

METODICA

PARAMETRI

INDICE

Dominio
del tempo

l

Dominio
della
frequenza

Bispettro

I

|

Burst
Suppression
Ratio

l

Rapporto tra
le potenze in
bande
selezionate

Potenza
relativa dei
picchi
significativi

:

I

Combinazione pesata dei parametri

I

BIS
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gEEG IN NEONATOLOGIA

In neonatologia I’EEG ¢ determinante per definire lo
stato d1 salute e di sviluppo in relazione all’eta
concezionale EC (numero di settimane che comprende 1l
periodo di1 gestazione piu I’intervallo di tempo
intercorso dalla nascita) del neonato.
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ANALISI QUALITATIVA
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ANALISI SEMI-QUANTITATIVA

aEEG >

rappresentazione del’ampiezza
picco-picco(ppA) del EEG

Principali indici aEEG:

* LM (lower margin), UM (upper
margin) 5°e 95°percentile correlato ai
valori d’ampiezza EEG nell’intervallo di

tempo considerato.
* Bandwidth= | UM — LM |

Metodo di Burdjalov - assegna un
punteggio a alternanza dei cicli
sonno-veglia, andamento del LM e
dell’ampiezza delle registrazioni , da
cui si ottiene un punteggio totale
compreso tra 0 e 13 che viene poi
correlato all’EG del neonato.

100+

25+

uV 10+
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ANALISI QUANTITATIVA

1. Calcolo del aEEG

1
400 500 600 700 800

2. Estrazione automatica di indici che, sulla base della
letteratura, correlano con ’'EC

-
o
o

AS X ASrned| *Asymmetry Transformed Index=37.1006

WW *EC Stimata= 27.4745

20 40 60 80 100 120 140 160 180 200
Samples(1/min.)

Index Values
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*Log Asymmetry Transformed

1 Index=5.4478
20 AMM f\ ' A ] EC Stimata= 34.038
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ANALISI QUANTITATIVA

3. Vengono estratti gli indici che meglio performano in una
popolazione di 30 registrazioni EEG

4. Viene calcolata la combinazione lineare di questi indici a
creare un nuovo indice

Prova1 | Prova2 | Prova3 | Prova4 | Prova5 | Prova6 | Prova7 | Prova8 | Prova9 | Prova10 | All | Risultati
Indice 1(AS) 0%
Indice 2(ASlog) X X X X X X X X X X X 100%
Indice 3(LM) X X X X X X X X X X X 100%
Indice 4(LMlog) 0%
Indice 5(BWlog) X X X X X X X X X X X 100%
Per difetto 1/6 2/6 2/6 116 0/6 2/6 2/6 2/6 0/6 2/6 8/30 | 23,64%
Accuratezza Per eccesso 4/6 3/6 1/6 3/6 3/6 4/6 2/6 2/6 3/6 2/6 12/30 | 44,55%
=0.5 per eccesso altrimenti per difetto 2/6 3/6 1/6 3/6 1/6 6/6 2/6 2/6 1/6 3/6 11/30 | 39,7%
Errore medio -0.0798 | -0,2592 | 0,12 0,248 0,705 -0,05 -0,17 0,11 0,33 0,22 0,29 0,114
Eta media TRAINING SET 32792 | 3275 33,08 32,86 32,75 32,79 33 32,71 32,79 3283 |3293| 3284
Eta media TESTING SET 335 33,67 32,33 33,16 33,67 335 32,67 33,83 335 3333 |3293| 3328

-2 Metodo automatico che
comporta un errore medio

di 0.11 settimane rispetto
alla EC
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LA tDCS

tDCS clectrode

"

Sparing R., Mottaghy FM., Methods 44: 329-337, 2008

Applicazione di correnti continue (DC) di
intensita <2 mA, sullo scalpo in
corrispondenza dell’area che si intende
modulare per alcuni minuti, anche piu
volte al giorno.
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PROTOCOLLO SPERIMENTALE
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RISULTATI CLINICI

|
A Pre stimulaton TR P ost stimulation

- Y **
\-“ ~L 1
: L I |
-
O ‘
o ‘e
S 40
‘b T -

L‘ _— =

StDCS AtDCS CtDCS

La tDCS anodica migliora la performance al
Word Recognition Task (WRT)
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IL PATTERN EEG NEL ALZHEIMER

Delta Theta Alpha Beta High Beta
Absolute Power

Aumento banda theta in zona fronto-
temporale

*Diminuzione banda beta in zona temporo-
parietale e occipitale

*Diminuzione coerenza in zona temporo-
parieto-occipitale
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IL PATTERN EEG CORRELA CON LO

STATO DEL PAZIENTE

<Pl 35
30 . 30
— 25 ? \\ t A T3 25 A T4
= 20 o .S i 20 . T6
& 15 \ *P3 & 15 * P4
x A SN g 7]
10 - A 10
3 5
0 0 -
19 21 23 2 19 21 23 25
MMISE score MNMISE score

All’aumentare del MMSE score diminuisce 'oscillazione beta
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EFFETTO DELLA tDCS SULLA ABSOLUTE |t Sai i
POWER

A Temporo-Parietal spectral power

40
ASP >0 *
O OAtDCS
20
E] S B CtDCS
= S o0
1 77}
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- ;
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-40
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: 20
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T - g O —
O i <
[t ‘ 20
= ASP <0
40
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EFFETTO DELLA tDCS SULLA ABSOLUTE

B Central spectral power
- *
Fp1 Fp2 Fp1 LN\ Fp2 ASP >0 %0 %
g F7 F3, F.z Fa F8 F7 k3, F.Z Fa F8 OAtDCS
20
[~ 3 —
= " OODF OO 4 memes
% \' Pa:‘> Pz P ) ( P3Pz (:;34 \/ o
=3 BNCor o T T N\Co1 o 3T ASP<0 20
AtDCS CtDCS 40 I
c3 Cz. Cc4
0y
SP >0 0/
o ASP >( 2 ADCS
z \?20 BCtDCS
= £
= 5 #ﬁ'
w <
= 20
s ASP <0 k
40
oz C4
" OAtDCS
0 B CDCS
g 0 ‘
o 2
Z2 30
40
=30 * *
-60
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EFFETTO DELLA tDCS SULLA COERENZA

Temporo-Parieto-Occipital Coherence

ACoh >0 A %

o 0O AtDCS
E - 10

S
= = B CtDCS
é é 0 oot
o) “ 10
] A Coh <0

20
\01-P3 O1-T5 T5-C3

o ACoh >0 4 % OAMCS
= T B CDCS
= g 0 o
- o
E “ 10
s ACoh <0

[
(]

|O1P3 OLT5 T5-C3 |
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EFFETTO COMPLESSIVO SUL EEG

Positive
effect

Negative
effect

Positive
effect

F

HIGH-FREQ

Negative
effect
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CORRELAZIONE CON EFFETTO CLINICO

0,3

0,2
| 4

0.1 1 R2=0.4118

4
-0,1 - %

-0,2

HIGH-FREQ
ASP

-0.3
AWRT score

[ aumento dell’oscillazione beta correla con il
miglioramento al WRT
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qEEG: RIASSUNTO DELLO STATO eGSR uERIaT

DELL’ARTE

« Il qEEG consiste nell’estrazione di parametri quantitativi
dal segnale elettroencefalografico che derivano
principalmente dall’analisi nel dominio del tempo e nel
dominio della frequenza

« Mediante le tecniche di qEEG e possibile individuare
pattern specifici di alcune patologie

« Il neurofeedback si basa sull’utilizzo del qEEG per
“normalizzare” i pattern patologici

« Il qEEG, anche se ancora non e entrato nella pratica
clinica, dimostra di essere un supporto affidabile alla
diagnosi e al decision-making
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ESERCITAZIONE
PRATICA CON
EEGLAB

[ Figure 5: erpimage()
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IL CASO DI STUDIO

Functionally Independent Components of the Late Positive
Event-Related Potential during Visual Spatial Attention

Scott Makeig,' Manssa Westerfield,25 Tzyy-Ping Jung,? James Covington,z Jeanne Townsend 25
Terrence J. Semnowski,>* and Enc Courchesnezs

1Neval Health Research Center, San Diego, Califomia 92186-5122, 2Children’s Hospital Research Center, San Diego,
California 02123, 3Howard Hughes Medical Institute, Computational Neurobiology Laboratory, The Sak Insttute for
Biological Studies, La Jolla, California 92037, and Departments of *Biology, and SNewrosciences, University of California
San Diego, La Jolla, Califomia 92003
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PROTOCOLLO SPERIMENTALE

<« s > ' SELECTIVE VISUAL ATTENTION
o ms EXPERIMENT
A | « Stimuli appear briefly in any of
five squares arrayed horizontally
above a central fixation cross.
* In each experimental block, one
® . (target) box was differently
e colored from the rest.
* Whenever a square appeared in
the target box the subject was
W asked to respond quickly with a
o right thumb button press.
* If the stimulus was a circular
Figure 1. Schematic view of the task. The top mice shows the time line of

a typical trial. BP, Button press. A, Screen before stimulation. The cross is dlSk’ he was aSked to lgnore lt'
the fixation point, and the lghidy sheded box is the attended location

during the ensuing 76 sec Hock. B, Appearance of a filled circle stimulus

at an unattended location; no response required. C, Appearance of a filled

sguare at the attended location in the discrimination task; button press

required. See Materials and Methods.

+ TARGET

IGNORE +

+ PRESS
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SCARICARE EEGLAB

WIKI DI RIFERIMENTO PER EEGLAB:
https:/ /sccn.ucsd.edu/wiki/ Getting_Started

Download EEGLAB zip file (requires Matlab)

Click here to download the latest EEGLAB version.
EEGLAB lastest version is version 14. EEGLAB older versions are available here and here. Revision details are available on the EEGLAB
wiki. If you have a version of Matlab older than 7.6 (2008b), download EEGLAB version 4.5b here.

To install EEGLAB

Unzip the EEGLAB zip file in the folder of your choice

Start Matlab
Change the Matlab path to the EEGLAB folder you have just uncompressed

. Type "eeglab" and press enter on the Matlab prompt

Download EEGLAB development head (requires Matlab)

Using the development head requires a special software called Git available for free on the Internet. Using the development head is
useful to benefit from the latest bug fixes and update your version of EEGLAB daily. Detailed steps to download the EEGLAB

Lol Ll s

development head are available on the EEGLAB wiki.

Download a compiled version of EEGLAB

EEGLAB compiled version for windows OS 32-bit does not require Matlab. If you have access to Matlab though, we recommend the
versions above since the EEGLAB compiled version is quite old (2009) and does not have all the features of the Matlab version.
Download the zip file here and follow instructions on how to install the EEGLAB compiled version on the EEGLAB wiki.
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APRIRE EEGLAB IN MATLAB

MATLAB R2012a
File Edt Debug FParallel Desktop Window Help
1| 239 & B 7| @ Currem Folder | /data/common/matiab feeglabll_0_3_1b - 'S

Shorcuns 2] How 1o Add  £] What's New

Cutrent Foldes =0 r X ll - At J Workspace - er x
o« matlab » eeglabll 0.3 1b» ~ 2 1 @- >» cd /data atlab/eeglabl] sl = N | Pseeaon.. -
Name > Name Min Value
A 1%%_F't.nt'-.'s:.: |
* Contents.m 1 L4
n},_.eg|_,,_,_,,. Command Histol “[O A x
- esglablicense.tut NB: EFFETTUARE PROCEDURA DI Set Path X 12 ( 58 |
PER INSERIRE LA CARTELLA IN CUI & cd /data/cons
SALVATO EEGLAB TRA QUELLE
PREDEFINITE (non serve il comando cd...)

| 4 Stan
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IL MENU PRINCIPALE

EEGLAB v11.0.3.1b
File Help *s

No current dataset

- Create a new or load an existing dataset:

Use "File > Import data” (new)
Or "File = Load existing dataset” (old)
- If new,

"File = Import epoch info” (data epochs) else
“File = Import event info” (continuous data
"Edit = Dataset info” (add/edit dataset info)
"File > Save dataset” (save dataset)

- Prune data: "Edit > Select data”

- Reject data: "Tools > Reject continuous data”

- Epoch data: "Tools = Extract epochs”

- Remove baseline: "Tools > Remove baseline”

- Run ICA: "Tools > Run ICA"

0 users in Chat
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SAMPLE DATASET

Load dataset(s) -- pop-loadset()

Look In: |C3 sample_data ~| |@| |{ay| 0 [BE( 5=

=] eeglab_data.set

=] eeglab_data_epochs_ica.set

File Name: eeglab_data.set

Files of Type: | (".5ET™, ".set) -
QOpen Cancel




»:“' ¢ DEGLI STUDI DI TRIESTE

“ABOUT THIS DATASET”

EEGLAB Tutorial Dataset

During this selective visual attention experiment, stimuli appeared briefly
in any of five squares arrayed horizontally above a central fixation cross.
In each experimental block, one (target) box was differently colored from
the rest. Whenever a square appeared in the target box the subject was
asked to respond quickly with a right thumb button press. If the
stimulus was a circular disk, he was asked to ignore it.

(Reference: Makeig et al.. J. Neurosci. 19:2665-80, 1999)

e Concatenation of three-second epochs from one subject, each
containing a target square in the attended location ('square' events,
left-hemifield locations 1 or 2 only) followed by a button response
('rt' events).

e Data stored in continuous data format to illustrate the process of
epoch extraction from continuous data.
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EDIT EVENTS

Edit 2 Event Values

Edit event values -- pop_-editeventvals()

Edit event field values (currently 154 events) Delete event |
Type || square
Position | | 2
Latency (sec) | | 1.0001
Event Num
Insert event | << | < | 1 > >> | Append event |

Re-order events (for review only)

Main sorting field: T — ~| _|Click for decreasing order
Secondary sorting field: Mo field selected ~ _|Click for decreasing order
Re-sort I

Help | Cancel | Ok |




/g UNIVERSITA
2 DEGLI STUDI DI TRIESTE

VISUALIZE DATA

Plot = Channel data (scroll).

Scroll channel activities —- eegplot()

Figure Display Settings Help ~

1 i A Stack |
: : : MNorm |

r

1 %ww l 7]
2 MMMMWWW L ‘ —
e v A N A e ;
T e N )
b i e e WWWM
e e g VA N VAN e e omaried:
[ ottt ot e %ﬂwﬁwﬂwﬂ
18 WWW’MWWWW
19 WMWMWWWWW
52 WWWWW\WM
PN NN St aartey i e A e e A SRR
27 WWWWWWM
N NN SN o et TNATEAY ST A arasetevis v Y
WMWWWW
%10 WWWMWMWWW a0
32 WWWNMWMWW -
0 1 Z J 4 a

Chan Time Value

cANCEU Eventtyp.] <<| <I[ 0 | 2] >3] dco. | ooo M1 20 [Iee= REECT |
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CHANNEL LOCATION

Edit channel info —- pop_chanedit()

Channel information ("field_name"):

Spherical radius ("sph_radius")
Channel type

Set head radius |
Set channel types |

Channel label ("label") | FPz Opt. head center |
Polar angle ("theta") | 0 Rotate axis |
Polar radius ("radius") | 0.50669 Transform axes |
Cartesian X ("X") | 0.99978
Cartesian Y ("Y") | 0 Xyz —> polar & sph. |
Cartesian Z ("Z") | -0.021016 Sph. -> polar & xyz |
Spherical horiz. angle ("sph_theta") | 0 Polar -> sph. & xyz |
Spherical azimuth angle ("sph_phi") | -1.2042

|

|

Reference Set reference |
Index in backup 'urchanlocs' structure 1 Figure 3
Channel in data array (set=yes) ¥4 Insert Tools Desktop Window Help ~
YR MO EA- @‘ a @‘ mO
Delete chan | Channel number (of 32)
Channel locations
Insert chan | << | < | 1 > | >> | Append chan |
«EOG1
Pot 2-D [ Plotradius (0.2-1, ]=auto) | Nose along +X | _Plot 3-D (xvz) |
Read locations | Read locs help | Look up locs | Save (as .ced) |  Save (other types) | e )
. o
Hel Cancel | ok | o Fcr eFcz CFCY

7 +C3 Gz «C4 TB
«CP5 <CP1 ACP2 «CP§

“P3 Pz P4

32 of 32 electrode locations shown
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CHANNEL SPECTRA AND MAPS

Plot & Channel spectra and maps.

Channel spectra and maps -- pop-spectopo()

Epoch time range to analyze [min_ms max_ms]: | 0 238304.6875
Percent data to sample (1 to 100): | 15
Frequencies to plot as scalp maps (Hz): | 610 22
|
|

Plotting frequency range [lo_Hz hi_Hz]:
Spectral and scalp map options (see topoplot):

2 25

‘electrodes’, 'off'

Help | Cancel | Ok |
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CHANNEL SPECTRA AND MAPS

Plot & Channel spectra and maps.

Pop_ spectopo: finding data discontinuities

Computing spectra (window length 512; fft length: 1024; overlap 0):
Plotting scalp distributions: ...

Click on each trace for channel/component index

6.0 10.0 22.0 Hz

Power 10*Iogm(|.LV2e’Hz)

5 10 15
Frequency (Hz)
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PRE-PROCESSING

e Change sampling rate
e FIR filtering

e Change EEG reference:

— Average reference: when the electrode montage covers nearly
the whole head (as for some high-density recording systems) 2
he advantage of average reference rests on the fact that outward
positive and negative currents, summed across an entire
(electrically isolated) sphere, will sum to 0 (by Ohm's law).

</ TP10
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INDEPENDENT COMPONENT ANALYSIS

e Tecnica utilizzata per separare sorgenti che, in principio,
sono tra di loro INDIPENDENTI

e Utilizzata per separare ARTEFATTI dal SEGNALE REALE

e |mplementata in EEGLab tramite il comando
Tools = Run ICA

Run ICA decomposition — pop_runica()

ICA algorithm to use (click to select) [runica ™
Commandline options (See algorithm help messages) | ‘extended’, 1
Channel type(s) or channel indices | ... ypes | ... channels

Cancel ‘ Help _ Ok
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RISULTATO

5 I CANALI NON SONO PIU RAPPRESENTATIVI
0 DELL’ATTIVITA DEI SINGOLI ELETTRODI, MA
-5 RAPPRESENTANO LE COMPONENTI

INDIPENDENTI

Continuous EEG Data



Creiamo due segnali sinusoidali, usando la funzione “sin”

A = sin(linspace(0,50, 1000)); % A
B = sin(linspace (0,37, 1000)+5); % B
figure;

subplot(2,1,1); plot(A);

% plot A
subplot(2,1,2); plot(B, 'r'")

% plot B

feiic. UNIVERSITA
=7 DEGLI STUDI DI TRIESTE
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Creiamo due combinazioni lineari di questi segnali:

M1 = A - 2*B; % mixing 1
M2 =1.73*A+3.41*B; % mixing 2
figure;
subplot(2,1,1); plot(M1); 3 T a
subplot(2,1,2); plot(M2, 't"); 2n ] AN
1 .||I III Fooh, ."I I', H III s I|
) S N B T A R A T N
L I'l ."I N | III V] f
1 '.I I|| | I.' S I'I III '.I { S 7
2 ".I ! ! / I'.I f \J/
-3 \/ | - 1 .'\-ffl 1
0 200 400 600 a0 1000
6
4t | I.I'll ) |"I'I I.I'|| 7
ar ' 'I II'. ' ' III'| IIII III|
al I| | III |I| III II,-' | III ||| IIII
-2 -I,"II II'| |I II", _."III |'|I I.'I I".I _
4l I". | I"-._ p I'I.II. I,-'I .:
.
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L’applicazione di un algoritmo di ICA mi permette di ricostruire i

due segnali di partenza

figure;
c = fastica([M1;M2]); % compute and plot unminxing
using fastICA
subplot(2,1,1); plot(c(1,:)); Bra h NN AN AT
subplot(2,1,2); plot(c(2,), 't'); u; /f H\ F|" IIH A ,,’ |'| | 'kll IIF ".ll / 1'. / E
VTV
0.5y ||II ll III I|II I|' '|II II|' III | I|II | |.|I ) ||| J‘I |
» 'll'., I." \., | | I"., 'I.'I y I"., ,.’I I".t IJJ' ll". .-'II II". /
13 200 - 40}'1)] 500 aﬁn - 1000
NB: download the ' A i . . . |
FastICA toolbox at : i f \ fy fod ln'l \ / \ f
05| - I II'I I'll lu'l I'I, Il'I \ N
[l ||I| I|| ||I |'I II| |'I ,Il ||I |I| III || Illl
os| | |,I |||' II'. Ilu' '.II lll' 'l,| ."I "|| |'|I i
1 ',I I,I'II '|I I,' \ ||'|I | I."I \ I"I \
1.5 'I "

' \ W \ W l.__.l A \ WA
0 200 400 600 ao0 1000
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DATA WHITENING

e |l processo diricostruzione delle componenti indipendenti
richiede uno step di “data whitening” = viene rimossa
ogni correlazione nella matrice dei dati

e La matrice di covarianza viene portata ad essere |la
matrice identita—> data la matrice dei dati D, cerco una
trasformazione V tale che

Per P=V*D = Cov(P) = |

Considerando Z = D-mean(D) {matrice centrata} 2
Cov(D) = Cov(Z)

Ponendo C=Cov(D) e V=C2- Cov(P) = |

Cov(P) = Cov( V*D ) = Cov( CV2*7 ) = CV2*xz*7’*C1/2 =
=Cclcct2=c*Ccl=1l.
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DATA WHITENING: ESEMPIO

e Scatter plot di due variabili casuali indipendenti

al
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DATA WHITENING: ESEMPIO

e Scatter plot di due ottenute dalla combinazione lineari di
due variabili casuali indipendenti

a0
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40 |

20

=20 F

40t

-60 F
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DATA WHITENING: ESEMPIO

e Scatter plot di due ottenute dalla combinazione linear di
due variabili casuali indipendenti dopo aver applicato il
procedimento di whitening

f
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ICA COMPONENTS

e Le componentiindipendenti si ottengono minimizzando la
gaussianita delle proiezioni sui due assi

. ..‘o‘l 0.. .:,. "-.o
. .: ..a‘ o -

L 23“ T T T T
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REIEZIONE DELLE COMPONENTI "8 DEGLISTUDI DI TRIESTE
ARTEFATTUALI

Tools = Reject data using ICA =
reject components by map

| Cancel | | Set threhsolds I | See comp. stats | | See projection I | Help | | oK I




#oe, UNTVERSITA
»/ DEGLI STUDI DI TRIESTE

REIEZIONE DELLE COMPONENTI

ARTEFATTUALI

Component 2 map

Lo spettro discendente e la
localizzazione frontale sono
tipici dell’artefatto oculare

Mo erpimage plotted
forcontinuous data

Activity power spectrum

¥ oof
Z 10F
S 10|
% | | |
o 0 10 20 30 40 o0
Frequency (Hz) Click su “Accept” per

tarlo diventare “Reject”
Cancel Values | acceeT | HELP oK - premere OK
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SOTTRAZIONE DELLE COMPONENTI "%/ DEGLISTUDI DI TRIESTE

ARTEFATTUALI

Tools & Remove components

n Remove components from data -- pop_subcomp() =

SX)

Component(s) to remove from data:
Component(s) to retain (overwrites "Component(s) to remove™)

Cancel Help Ok

What do you want to do with the new dataset?
Name It Coniinuous EEG Daia oruned wiih iGA urul Edit description
Save it as file: | Browse |

Some changes have not been saved. What do you want to do with the old dataset?
Overwrite it in memory (set=yes; unset=create a new dataset)
Save 1t as fle: | Browse

Cancel Help Ok
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VISUALIZE NEW DATA

Plot = Channel data (scroll).

Figure Display Settings Help
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CONFRONTO CON | DATI ORIGINALI

F|g ure Dis p|ay Settin gs Hel p Artefatto iniziale diminuito dOpO la
reiezione
i i . /\
FPz W
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s SR APV A ey “w "'*'
o A o S
FC3 W 3
FCAH W\WWWW
FC2 WMWMW
B g o ot & YV Pt e vy A Ay AU gy IO e
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